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1. Business Intelligence (BI) Concepts 
2. Introduction to Business Intelligence 

3. The importance of Business Intelligence 

4. The relation between Business Intelligence and Data Warehouse 

5. Tools and Technologies in Business Intelligence area 

 

1.1 INTRODUCTION TO BUSINESS INTELLIGENCE 

Business Intelligence (BI) is a process of analyzing data through technology and presenting it to 

the end user(s) which helps them to make an informed decision. With the use of historical and 

current data, a BI tool serves predictive view. Usually, a BI tool can perform tasks like data 

connection, data mining, data transformation, data modelling through building relationships, 

complex calculations, report building, dashboard creation, online analytical processing and 

predictive analysis. 

 

1.2 RELATION BETWEEN BUSINESS INTELLIGENCE AND DATA 

WAREHOUSE 

To understand the relationship between BI and Data warehouse, lets first understand what is 

Data warehouse? 

 

DATA WAREHOUSE 

It consists of a huge storage of data gathered from single or many sources to aid the process of 

making an informed decision at any level of an enterprise. A typical data warehouse follows an 

ETL (Extract, Transform, Load) process. 

 

ETL 

Extract :- The first step in using Data Warehousing is to extract data from single or multiple 

sources to load in its environment. 

 

Transform :- The Data which has been extracted, may not come in the desired format or size etc, 

so there may be the need to transform the incoming data to meet business requirements and 

objects. 

 

Load :- Once the data is being transformed, its ready to be loaded in targeted tables. 

 

1.3 RELATION BETWEEN BUSINESS INTELLIGENCE AND DATA 

WAREHOUSE (CONT.) 

A Business Intelligence tool takes data from a Data warehouse to generate reports and help the 

end user to make informed decision. By this, we can call Data warehouse as a part of a complete 

Business Intelligence process. 
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1.4 BI TOOLS 

• Microsoft Power BI 

• Tableau 

• Sisense 

• Looker 

• datapine 

• Zoho Analytics 

• Yellowfin 

• Answer Dock 

• Hotjar 

• ReportPlus 

• QlikView 

• SAP BusinessObjects Lumira 

• SAP Crystal Reports 

• SAP Business Intelligence 

• Vista 

• Clootrack 
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2. MICROSOFT POWER BI (MSPBI) INTRODUCTION 

 

 
Microsoft PowerBI (MSPBI ) introduction 

1. Power BI introduction and overview 

 

2. Power BI Architecture 

 

3. Introduction and Power BI in Desktop 

 

4. Why Choose Power BI over Excel 

 

 

 

2.1 POWER BI INTRODUCTION AND OVERVIEW 

Power BI is a collection of software/tools that works in synchronization to turn unrelated sources 

of data into meaningful and interactive insights. Power BI support 100’s of data sources 

including the most common one’s like Excel spreadsheets, Text/CSV, SQL, Oracle etc. 

 

 

 

PARTS OF POWER BI 

 

• Power BI Desktop - A Windows desktop application 

• Power BI service - for Windows, iOS, and Android devices 

• Power BI mobile apps - An online SaaS (Software as a Service) service 

• Power BI Report Server - to publish Power BI reports to an on-premises report server, 

after creating them in 

 

 

 

POWER BI FLOW 

 

It starts with connecting to data then transforming it, building relationships and finally creating 

reports and publishing it to Power BI service. Later it can be shared so that end users in the 

Power BI service and mobile devices can view and interact with the report. 
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2.2 POWER BI ARCHITECTURE 
 

 

 

2.3 INTRODUCTION TO POWER BI DESKTOP 

It starts with connecting to data then transforming it, building relationships and finally creating 

reports and publishing it to Power BI service. Later it can be shared so that end users in the 

Power BI service and mobile devices can view and interact with the report. 

 

2.4 WHY TO CHOOSE POWER BI OVER EXCEL 

• Store and analyze huge amounts of data smoothly: With powerful compression 

algorithms to import and cache the data within the .PBIX file, it can easily handle huge 

databases. On the other hand, Excel struggles even in opening an file having few hundred 

thousands of rows. 

• Find Data insights and show trends in minutes: With build-in time intelligence functions, 

it becomes very easy to dig into vast amount of data and draw trend (unlike Excel). 

• User Friendly Report Interface: It’s just about drag and drop of the fields when it comes 

create impressive visualizations. Even a complex report with diverse visualizations won’t 

take more than 10 to 20 mins to create. If you think that pre- enabled visualizations are 

not enough, then you can import a custom visualization anytime in just few clicks from 
the library of 100’sof custom visuals. 

• Publishing and Sharing the Report: Just by hitting the publish button, one can publish the 

report on Power BI service and whosoever has access to it can view the updated report or 

dashboard always. On the other hand, in Excel, one need to send emails or putting in the 

share drive or share point and telling them that we have updated the file. 

• Defining Roles: Power BI gives us an option to define roles to make sure people from 

different departments or locations can see only their respective data (Which can’t be done 

in Excel). 
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3. INTRODUCTION & GETTING STARTED 

• How to get Power BI desktop 

• Power BI Desktop Interface 

• Change Default Settings 

 

3.1 HOW TO GET POWER BI DESKTOP? 

Go to https://www.microsoft.com/en-us/download/details.aspx?id=45331. 

Check for the system requirements and hit the download button and you are good to go. 
 

 

 

 

PBI DESKTOP - FIRST SCREEN 

Below is the first screen you will get, once you open PBI desktop. You will be prompted to sign- 

in but sign-in is required only when it comes to publishing the report to PowerBI.com, rest the 

whole model can be created without sign- in. Note: Sign-in can be done only using an official 

email ID. i.e. it cannot accept personal email ids like Gmail, yahoo etc. 
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3.2 POWER BI DESKTOP INTERFACE 
 

 

 

 

 

CONNECT TO POWERBI APP FROM MICROSOFT STORE 
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How Microsoft App look like? 
 

 

 

POWER BI DESKTOP INTERFACE (CONT.) 

• Report Name: We can rename the report while saving the same for the first time. 

• Views: 

 

o Report View – Under this we can use different visualizations to build report. 
o Data View – Once data is being loaded to PBI Desktop, the same can be seen here 

in the form of tables and fields. Here we can create calculated columns and 
measures. 

o Relationship View – This view is useful to build relationships to create data 
model. 

 

• Page Name: We can have multiple pages into a single report. Each page contributes a part 

of a report. Its just like “Sheet” tabs in MS Excel. 

• Add New Page: By clicking the plus sign, we can add a new page in the report. 

• Tabs: 

 
o Home: This is a general-purpose tab and used for connecting new data, editing 

queries etc. 

o View: One can set the view and even design the phone layout too. 

• Help: It’s a good resource to learn this program and even post your queries in PBI 

forums/community. 
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POWER BI DESKTOP INTERFACE (CONT.) 

• Publish Report: This helps in publishing the reports created in Power BI desktop to 

Power BI Service. 

• Sign-In: To publish the report or import new visualizations, one has to sign into Power BI 

service. 

• Visualization Pane: Here we can choose among many visualizations like charts, slicers, 

maps etc. 

• Filters Pane: PBI Desktop provides three levels of filters i.e. Visual, Page & Report level 

filter. 

• Drill-Through Filter: Helps in accessing the detailed report of an item. 

• Drop Fields pane: As every visualization needs one or multiple fields to show data into it. 

This pane facilitates dropping the desired fields from the fields pane. 

• Format Pane: Every visualization has different formatting options; this pane helps in 

formatting the selected visualization. 

• Fields Pane: Show all the connected data tables and fields. •Feature Update Notification: 

This will show a notification for any new update released from Microsoft PBI team. 

 

 

 

3.3 CHANGE DEFAULT SETTINGS 

• Go to File -> Options & Setting -> Options. 

• Data Load – Deselect “Update Relationships” and “Auto detect new relationships after 

data is loaded.” 

• Regional Settings – select “English (United States)” 

• Preview Features – deselect any active feature. 
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4. CONNECT TO VARIOUS DATA SOURCES 

Connecting PowerBI with Different Data sources 

• Connect to CSV files. 

• Connect to Excel 

• Connect to text. 

• Connect to SQL Server 

• Connect to a Web page. 

• Enter data directly. 

• Analysis Services Tabular data 

• Connect to Direct SQL Query 

 

 

 

What is the purpose of the ‘Get Data’ icon in Power BI? 

When users click on the Get Data icon in Power BI, a drop-down menu appears, and it shows all 

data sources from which data can be ingested. Data can be directly ingested from any source 

including files in Excel, CSV, XML, JSON, PDF, and SharePoint formats and databases such as 

SQL, Access, SQL Server Analysis Services, Oracle, IBM, MySQL, and much more. Also, 

Power BI datasets and Power BI data flows are compatible. Data can also be taken in from Azure 

and other online sources. 
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4.1 CONNECT TO CSV/TEXT/EXCEL FILES 

Home Tab -> Get Data -> Click on Text/CSV or Excel -> Choose File -> Open 
 

 

 

 

4.2 CONNECT TO CSV/TEXT/EXCEL FILES (CONT.) 

 

When we click on the open button, a new dialogue box will get open. In which, following 

delimiter can be selected to extract the data– 

 

• Comma 

• Colon 

• Equal sign 

• Semicolon 

• Space 

• Tab 

• Custom 

• Fixed with 
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4.3 CONNECT TO CSV/TEXT/EXCEL FILES (CONT.) 

Load the dataset from Get data. 
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Choose which dataset you want to choose- For long dataset search via navigator. 

 

 

Select particular excel sheet and transform dataset. 
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4.4 CONNECT TO SQL SERVER 

Home Tab -> Get Data-> Choose SQL server Database or More-> Choose SQL server database - 

> Connect. 

 

 

 

 

4.5 CONNECT TO SQL SERVER (CONT.) 

• Following are the list of available fields in order to connect Power BI desktop to SQL 

Server Database 

• Server- In this section we will provide default SQL server Instance. 

• Database- If we want to use custom SQL query then this option is required. 

• Data Connectivity Mode- Choose whether we want to import or directly connect through 

query. 
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4.5 CONNECT TO SQL SERVER (CONT.) 

Windows – Here we can access the SQL Server database using our windows credentials. 

 

 

4.5 CONNECT TO SQL SERVER (CONT.) 

Once PBI Desktop is connected to SQL server, it will open up navigator to choose the files or 

tables we would like to connect to in our model. 
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4.5 CONNECT TO SQL SERVER (CONT.) 

After selecting the tables that need to be added in the model, we can click on “Load” to load 

them into PBI environment directly. 
 

 

 

 

4.6 CONNECT TO A WEB PAGE 

Home Tab -> GetData -> Web data -> Type the URL -> Connect. 
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4.7 CONNECT TO A WEB PAGE (CONT.) 

Once Power BI desktop connects with the web page, it presents the data available into the 

navigator window. When we click on any table showing inside the navigator pane, it will display 

the preview of data. When we select the Load option in the navigator, Power BI imports the 

selected item data and makes them visible inside the Fields Tab. 
 

 

 

 

4.8 ENTER DATA DIRECTLY 

Home Tab -> Enter Data This will trigger “Create Table” dialogue box. 
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4.8 ENTER DATA DIRECTLY (CONT.) 

To Insert a new Column or row just click on the asterisk (*) symbol which is showing on both 

sides of the Column and Row. At the bottom, we can define Table Name, for example – 

Customer data. 

 

 

 

 

4.9 CONNECT TO DIRECT SQL QUERY 

Home -> Get Data -> SQL server database -> Type server Name -> Type Database (Optional) -> 

Click on Direct Query. Enter the credentials to access the database. Note: Rest of the steps are 

same as we discussed above in “Connect to SQL Server Database”. 
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5. POWER QUERY FOR DATA TRANSFORMATION 

• Using SQL Different versions of Power Query 

• Power Query Introduction 

• Query Editor 

• Manipulation in Power Query 

 

5.1 POWER QUERY 

Power Query acts as an “ETL” tool for Power BI i.e. it Extracts data from one or multiple 

sources, Transform that data and finally Load it into Power BI environment. 

 

It also facilitates an “Applied Steps” feature, where whatever we do, will get recorded as steps 

and upon updating the source data, all those steps will get applied to them automatically and this 

way the creator of the report needs not to repeat the steps. 

 

 

 

5.2 HOW TO OPEN POWER QUERY EDITOR? 

Power query editor is a separate window which can be accessed by either of the following ways: 

 
o Power BI window Home -> Get Data -> Choose the respective data source -> Browse the 

file -> “Edit”. (Here “Edit” button will open Query editor). 

o Power BI window Home -> “Edit Queries” 
 

 



Page 23 of 60  

5.3 POWER QUERY EDITOR INTERFACE 

Home Tab -> GetData -> Web data -> Type the URL -> Connect 

 

 

5.4 POWER QUERY EDITOR INTERFACE (CONT.) 

• Queries pane: This will show all the queries or the data with which our model is 

connected to. 

• Applied Steps: List of steps that has been recorded while using the Power Query Editor. 

When the data in the data source will be updated then we need to just refresh our Power 

BI model and all the transformation steps which has been recorded by the Query Editor 

will get applied to updated data and that saves lots of repetitive work and time. 

• Table Name: We can rename the table name to something that helps in recognizing the 

same in Power BI environment. 

• Formula Bar: As Power BI use “M Code” language. The same can be seen here for each 

applied steps been recorded by Query Editor. 

• Tabs: 

• File: General customizations related to Query Editor window can be done here. •Home: 

Major options can be found under this tab like et Data, Append &Merge Query, Data 

source settings etc. 

• Transform: This helps in transforming the existing column(s) like changing the data 

types, change formatting, Pivot or Unpivot columns etc. (Note: These operations will be 

applied only on the selected column(s). 

• Add Column: This adds a new column based on calculation or existing column. •View: 

Here we can turn on or off the formula bar, whitespace etc. 

• Help: It’s a good resource to learn this program and even post your queries in PBI 

forums/community. 

• Close & Apply: Once transformation of the data is done, hitting this button, Power Query 

will load the data into Power BI and apply all the recent changes. 
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5.5 DATA TYPES 

Make sure the suitable data type must be assigned to each column. 
 

 

 

 

 

5.6 Transformation procedure happens in Power Query 

What is Power Query? Power query is an ETL tool which helps you to clean, shape, and modify 

data utilizing instinctive interfaces without doing anything. M-code is a new programming 

language that is used in power query. 
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5.7 MERGE & APPEND QUERIES 

Merge Queries 

This allows us to join two tables based on one common column (like Vlookup function in Excel) 

•Example: Merging Sales & Product table based on Product key in both the tables. 

 

Append Queries 

It allows us to combine two or more tables that shares the same table structure and data types. 

•Example: Appending two years of sales data. 
 

 

 

 

 

In Power Query there is no step to undo or ctrl+Z will also not work thus follow 

following procedure to remove applied steps 
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5.8 Choose Apply and close 
 

 

 

 

5.9 INCLUDE IN REPORT REFRESH 

Once we click the “Refresh” command from the home tab in Power BI desktop window, it will 

refresh all the queries presenting Query editor. But queries which won’t change often like lookup 

table (e.g. Product table, Territory Table etc.), we can set it to exclude from refresh by right 

clicking on the query in Query editor window and deselecting “include in Report Refresh” 

option. 
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5.10 DEFINING DATA CATEGORIES 

Data Categories are used to define geographical data. This will help in plotting the same on the 

3D map, where the “Bing map” will recognize these fields. 

 

To define the same, select the respective column and then go to Modelling tab in Power BI 

desktop and choose the related option. 
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6. Data Modelling in PowerBI 

o Data Model 

o Lookup Tables 

o Primary & Foreign Key 

o Creating Table Relationships 

o Snowflake Schemas 

o Editing Relationships 

o Relationship Cardinality 

o Filter 

o Introduction to DAX 

o Calculated Columns 

o Measures 

o Implicit & Explicit Measures 

o Calculated Tables 

o Row Context vs Set Context 

o Advanced calculations using Calculate functions. 

o Time Intelligence Functions 

6.1 DATA MODEL 

 

• When the collection of two or more independent tables are connected through 

relationships based on common fields forms a Data Model. 

• Data Modelling helps in building custom calculations on the existing tables, which can 

further be used directly into Power BI visualizations. 

 

6.2 WITHOUT DATA MODEL 

 

In our sample data, if the relationship between returns table and products table do not exist then 

using the fields in the report view from both tables will leads to independent and meaningless 

results. 
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6.3 WITH DATA MODEL 

Now both returns and Product tables are connected. Here, we are getting the correct result. 

 

 

6.4 BUILDING RELATIONSHIPS 

This can be done by either picking up common keys and dropping them on related table or by 

using “Manage Relationship” option. 

 

6.5 UNDERSTANDING “SNOWFLAKE” SCHEMAS 

When a Lookup table has a primary key which doesn’t exist as foreign key in a Data table but in 

another lookup table, which in turn is connected to the data table, the relationship formed 

between the Lookup Tables called a “Snowflake” schema. 
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6.6 EDITING EXISTING RELATIONSHIPS 

In the relationship view either one can double click on the relationship thread or can go to Home 

-> Manage Relationships. 
 

 

6.7 ACTIVE AND INACTIVE RELATIONSHIPS 

Having two foreign keys in a data table can facilitate two relationships with one Lookup Table at 

the same time. But only one can be activated at one time. E.g. date field in calendar lookup table 

can have two relationships with Sales table with “Transaction Date” and Stock Date” field. But 

only one can remain active at one time. Note: An inactive relation will be shown as a dotted line 

in relationship view. 
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6.8 RELATIONSHIP CARDINALITY 

Cardinality refers to the uniqueness of values in a column. Here, high cardinality means a higher 

number of unique values and low cardinality means higher number of repetitive values. 

 

6.9 FILTER FLOW 

Filter flow passes downstream from lookup tables to data tables 

 

6.10 BOTH-WAY FILTER 

We can have a two-way filter too i.e. it can flow from Lookup table to Data table and at the same 

time Data table to lookup table. Note: This can be dangerous to have both way filter when we 

have more than one Data table in the model. 

 

 

6.11 HIDING FOREIGN KEYS 

Its quite usual for any user to use foreign key, which will give us an incorrect result. To make 

user forcefully use a Primary key, we can hide the foreign keys from the report view. 
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6.12 INTRODUCTION TO DAX 

Data Analysis Expressions (DAX) is a collection of operators and functions used to calculate and 

return one or more values. This helps in creating new and meaningful information from existing 

data present in our model. We can use DAX by either creating a “Calculated Column” or by 

creating “Measures”. 

 

 

 

6.13 CALCULATED COLUMNS 

These are new formula-based columns which can be added into the tables. These are calculated 

based on the entire column or table. It understands row context, so for basic statistical functions 

like sum, count, average etc. this will not be useful. 

 

 

 

6.14 MEASURES 

Measures are used to create new calculated values. These also works on entire columns or tables 

and entertain filter context. These values can’t be seen in data view. 

 

 

 

6.15 MEASURES VS. CALCULATED COLUMNS 

Measures 

 

o Creates new calculated value. 

o Understand filter context. 

o Works on entire column or table 

o Can only be seen in Report view. 

o Doesn’t increase file size. 

Calculated Columns 

 

o Create a new column. 

o Understand row context. 

o Works on entire column or table 

o Can be seen in both Data and Report view. 

o Increase file size. 
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6.16 ADDING MEASURES 

Measures can be added either by right clicking within the table orby using “Quick Measures”. 

 

 

 

6.17 IMPLICIT & EXPLICIT MEASURES 

• Implicit Measures These are being created when we drag a numerical field into the values 

pane of a visualization in the report view and choose any pre-defined calculation on the 

same as Sum, count, average etc. These can be accessed only in the visualization where 

these have been created. 

• Explicit Measures These are being created by entering the DAX function. These can be 

accessed anywhere in the report and can be used in other DAX calculations too. 

 

 

 

6.18 CALCULATED TABLES 

Calculated Tables are the new tables to be added to the model using DAX. Usually, we import 

data from different sources and use them as tables in Data and report view but Calculated tables 

are being created using DAX on existing data. 

 

 

 

6.19 DAX Operators 
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6.20 What is DAX ? 

It is a formula expression language called (DAX) that can be used with various visualization 

tools like Power BI. It is also known as a functional language, where the full code is kept inside a 

function. 
 

 

6.21 How to apply DAX ? 

Go to dataset, right click and click on measure or table 
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6.22 All About DAX 

New Measure is created with writing DAX m code language for mathematical operations and 

will not retain extra data storage in your working data. While New table is created by same by 

writing DAX but table create new calculated column and will retain space in your working 

space. 

 

What are the data types of Dax? 

Data types of Dax are: 1) Numeric, 2) Boolean, 3) Date Time, 4) String, and 5) Decimal. 

 

Benefits of using Variables in DAX. 

Here, are benefits of using DAX function: ·By declaring and evaluating a variable, the variable 

can be reused multiple times in a DAX expression, which helps you to avoid additional queries 

of the source database. ·Variables can make DAX expressions more useful and logical. 

·Variables is only scoped, which should be measure or query which can't be among measures. 

 

 

7. REPORTS IN POWERBI 

• Connect to Direct SQL Query in Power BI Desktop 

• Create a new Power BI report. 

• The report editor in Power BI 

• Add a page to a Power BI report. 

• Add a filter to a report in Power BI 

• Save a report in Power BI 

• About filters and highlighting in Power BI reports 

• How to use report filters 

• Analyze in Excel 

• Other Miscellaneous operations 

 

7.1 CONNECT TO DIRECT SQL QUERY IN DESKTOP 

DirectQuery – no data is imported or copied into Power BI Desktop. For relational sources, the 

selected tables and columns appear in the Fields list. For multi-dimensional sources like SAP 

Business Warehouse, the dimensions and measures of the selected cube appear in the Fields list. 

As you create or interact with a visualization, Power BI Desktop queries the underlying data 

source, which means you’re always viewing current data. Many data modeling and data 

transformations are available when using DirectQuery, though with some limitations. When 

creating or interacting with a visualization, the underlying source must be queried and the time 

necessary to refresh the visualization is dependent on the performance of the underlying data 

source. When the data necessary to service the request has recently been requested, Power BI 

Desktop uses recent data to reduce the time required to display the visualization. Selecting 

Refresh from the Home ribbon will ensure all visualizations are refreshed with current data. 
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REPORT VIEW (INTERFACE) 

 

 

 

7.2 There are 3 different types of views in PowerBI. 

• Report View: Users can add visualizations and additional report pages and publish the 

same on the portal from here. 

• Table/Data View: Data shaping can be performed through Query Editor tools. 

• Model/Relationship View: Users can manage relationships between datasets in this view. 
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7.3 REPORT VIEW 

Report view – For making reports using different visualization charts. "Report" view is where 

you create, design, and interact with visualizations based on your data. 

 

 

7.4 TABLE VIEW 

Table view – "Table view" is a feature that allows you to interact with your data in a tabular 

format, like how data appears in a spreadsheet. 
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7.5 MODEL VIEW 

Model view – "Model view" is a feature that allows you to view and manage the relationships 

between different data tables within your dataset. 
 

 

 

 

 

7.6 POWER BI DESKTOP FILTERS 

• Visual Level Filter: This is applied only to the active visual. 

• Page Level Filter: This gets applied to all the visuals in the existing page. 

• Report Level Filter: This is applied to all the visuals in all the existing pages in the report. 
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7.7 How can we filter data in Power BI? 

Data can be filtered using various filters that are available in Power BI, implicitly. There are 

basically three types of filters, namely, Page- level filters, Drillthrough filters, and Report-level 

filters. 

 

 

7.8 REPORT INTERACTIONS 

By default, all the visualizations are connected to each other and filtering items in one visual will 

impact others too. Through “Edit interactions” we can prevent certain visualizations to get 

filtered. 
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8. Reports and Visualization types in Power BI 

• Types of visualization in a Power BI report 

• Custom visualization to a Power BI report 

• Types of visualization in a Power BI report 

• Add a custom visualization to a Power BI report 

• Download a custom visual from the gallery 

• Getting started with color formatting and axis properties 

• Change how a chart is sorted in a Power BI report 

• Move, resize, and pop out a visualization in a Power BI report 

• Drill down in a visualization in Power BI 

 

 

 

9. TYPES OF VISUALIZATION IN A POWER BI REPORT 

• Area 

• Stacked Area 

• Bar/Column 

• Clustered Bar/Column 

• 100% Stacked Bar/Column 

• Combo •Ribbon 

• Tree map 

• 3D Map 

• Filled Map 

• Card/KPI 

• Slicer 

• Table 

• Matrix 

• Doughnut 

• Funnel 

• Gauge 

• Line 

• Pie 

• Scatter 

• Waterfall 
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TYPES OF VISUALIZATION IN A POWER BI REPORT 

Accessing the different visualizations from PowerBI Report view: -26 Charts are provided 

default and More can be imputed with paid login id. Charts are visible under Build portion. 
 

 

 

 

Activating all the pane from format option at rightmost side of the report view 
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Making visualizations in report view 

Making title for visualization using Text Box option available on top and with formatting option 

visible in white strip we can entitle the visualization. 
 

 

 

 

Creating bar graph visualization 

Choose horizontal bar graph option from insert or build suggestions. Choose values for x-axis 

and y-axis Build option, click on 3 dots available on top of bar graph to get option like Export 

data, Show as a table, Remove, Spotlight, Sort axis and Format. 
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Formatting the Visualization 

Format Pane: The "Format" tab contains several sections, each with its own set of formatting 

options. These options may vary depending on the type of visualization you've selected. 

 

Explore different formatting option to create visualization. 

• Data colors: Customize the colors used within the visualization, including data series 

colors, background colors, and font colors. 

• Data labels: Control the appearance of data labels, including font size, color, position, 

and formatting. 

• Title: Customize the title of the visualization, including font size, color, alignment, and 

formatting options. 

• X-axis / Y-axis: Format axis labels, titles, scales, and other properties specific to the X 

and Y axes. 

• Legend: Adjust the appearance and position of the legend, including font size, color, 

orientation, and visibility. 

• Shapes: Add shapes or lines to the visualization and customize their appearance, such as 

color, style, and thickness. 

• Tooltip: Customize the tooltip that appears when hovering over data points in the 

visualization, including the information displayed and formatting options. 

• Small multiples: Instead of viewing a single large chart, small multiples allow users to 

compare different categories or dimensions within the same chart type. 
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Exporting Data 

Users can export the data displayed in visualizations such as charts, tables, matrices, and other 

visual elements. 
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Show as table 

"Show as table" is a feature that allows you to view the data underlying a visualization in a 

tabular format 
 

 

 

 

 

 

 

Removing 

Option to remove particular visualization. 
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Spotlight 

To create spotlight on visualization 
 

 

 

 

 

 

 

 

Sorting graph 
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Focus mode 

Focus mode in Power BI allows users to view a visual or a report in full-screen mode, providing 

a distraction-free environment for focused analysis. 

 

 

 

 

 

Types of Visualization 

9.1 Card 

"Card" visualization is a simple yet powerful way to display a single value or a key performance 

indicator (KPI) 
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9.2 Bar graph 
 

 

9.3 Pie chart 

• Legend: Color-coded key showing categories or segments. 

• Value: Numerical data associated with each segment. 

• Tooltip: Additional info displayed on hover. 

• Details: Specific data points or records behind each segment. 
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9.4 Ring Chart/Donut 

• Legend: Color-coded key showing categories or segments. 

• Value: Numerical data associated with each segment. 

• Tooltip: Additional info displayed on hover. 

• Details: Specific data points or records behind each segment. 

 

 

9.5 Line chart 

line chart is a type of visualization used to represent data trends over time or any ordered 

dimension 

 

• Secondary Axis: Allows plotting two measures with different scales on the same chart. 

• Small Multiple: Displays multiple charts, each representing a subset of data, for 

comparison. 

• Legend: Color-coded key identifying categories or measures represented in the chart. 
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9.6 Area Chart 

• Secondary Y-axis: Allows plotting two measures with different scales on the same chart. 

• Legend: Color-coded key identifying categories or measures represented in the chart. 

• Tooltip: Provides additional information when hovering over data points. 
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9.7 Stack Area Chart 

A stacked area chart in Power BI is a type of visualization that displays multiple series of data as 

layers, stacked on top of each other. Each layer represents a different category or subgroup of the 

data, and the combined height of the layers at any given point represents the total value of the 

data for that category. 
 

 

 

9.8 Tree map 

A tree map in Power BI is a type of hierarchical visualization that displays hierarchical data as a 

set of nested rectangles. Each rectangle represents a category or group, and its size corresponds 

to a quantitative measure, such as sales revenue or population. 
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9.9 Map 

• Location: Represents geographic data points plotted on the map. 

• Legend: Color-coded key identifying categories or values on the map. 

• Latitude and Longitude: Coordinates specifying the location of each data point. 

• Bubble Size: Size of data markers representing quantitative measures on the map. 

• Tooltip: Provides additional information when hovering over data points. 
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9.10 Gauge Chart 

A gauge chart in Power BI is a type of visualization used to display a single value within a 

predefined range or target. It resembles a speedometer or gauge found in dashboards and 

instruments. Single Value Representation: A gauge chart typically represents a single value, such 

as a key performance indicator (KPI), a progress metric, or a target attainment percentage. 
 

 

 

 

9.11 Matrix 

A matrix in Power BI is a data visualization tool that organizes data in rows and columns, similar 

to a spreadsheet or a pivot table. 
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9.12 Slicer 

Slicers are interactive visualizations that allow users to filter data across multiple visualizations 

and reports dynamically. They are typically used to filter data based on specific criteria, such as 

categories, time periods, or regions, enabling users to focus on relevant subsets of data. 

 

 

 

 

 

9.13 Decomposition Tree 

The decomposition tree is a powerful visualization tool in Power BI that enables users to analyze 

and understand the factors driving a particular metric or measure. 
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9.14 Q&A 

• Q&A (Question and Answer) is a feature in Power BI that allows users to ask questions 

about their data using natural language queries and receive instant visualizations and 

insights in response. Here's how it works: 

• Natural Language Queries: Users can type questions in plain English (or other supported 

languages) directly into the Q&A box in Power BI. They can ask questions about their 

data, such as "What were the sales last month?" or "Show me a pie chart of sales by 

region. 

• " Natural Language Processing (NLP): Power BI's Q&A feature utilizes natural language 

processing (NLP) technology to interpret and understand the user's query. It analyzes the 

text input to identify keywords, entities, and intents, allowing it to generate relevant 

visualizations and insights. Instant Visualizations: After interpreting the user's query, 

Power BI dynamically generates visualizations that best represent the requested 

information. It automatically selects the appropriate visualization type based on the data 

and the nature of the query. 
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9.15 CUSTOM VISUALIZATION TO A POWER BI 

Power BI also provides us an option to download custom visualization from the Microsoft App 

store. 

 

 

VISUALIZATION SETTINGS 

These settings are different for each visualization. 
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VISUALIZATION DRILL DOWN OPTION 

When a visual has a hierarchy, it supports drill down/up feature e.g. putting “Product Category, 

Sub-Category and Product” into a matrix will automatically enable dill down/up feature. 

 

 

 

 

DRILLTHROUGH FILTERS 

It helps in creating a dedicated page for specific entities. A detailed page can be created for the 

user to dig-in from the dashboard. The moment we add a drill through filter, Power BI 

automatically adds a back button to go back to the overview. 
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10. Dashboard in Power BI 

• Create a Power BI dashboard Dashboard tiles in Power BI 

• Pin a tile to a Power BI dashboard from a report. 

• Pin a tile to a Power BI dashboard from Excel. 

• Publish PowerBI report. 

 

 

 

POWER BI DASHBOARD 

• This is a single page view of the overall story through visualizations. For detailed 

summary, user can visit the related reports. 

• Dashboard is a feature of Power BI Service. This is unavailable in Power BI Desktop. A 

pro license if needed to access Power BI Service. 

 

 

 

DIFFERENCE BETWEEN DASHBOARD & REPORT 

DASHBOARD: - 

• Data source can be one or more reports or data sets 

• Only One page 

• Not available in PBI Desktop 

• We can’t do filtering or slicing in a Dashboard 

REPORT: - 

• Data source can be only single dataset per report 

• One or more pages 

• Available in PBI Desktop 

• Filtering or slicing can be done here 

 

 

 

TILES IN DASHBOARD 

 

One can add a new tile from within the Dashboard. Clicking on these tiles will take back into the 

report. Even a whole report page can be pinned to dashboard. This is also considered as pinning 

a live tile because tiles from reports are synced and upon any update in report will update these 

tiles in dashboard too. 
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PIN AN ENTIRE REPORT PAGE TO PBI DASHBOARD 

If the requirement is to pin more then one visualization in the dashboard then its better to pin the 

entire report. When we pin the complete page then the tiles become live, we can interact with 

them directly from the dashboard. 

 

DATA ALERTS IN POWER BI SERVICE 

Setting a data alert is possible with Power BI Pro license. Alerts can only beset on the tiles 

pinned from report visuals, and only on gauges, KPI’s and cards. Alerts can’t be set on the 

streaming tiles created directly on the dashboard. 

 

 

 

How do create actions and navigations in Power BI? 

To Navigate to a certain report on click, you must Bookmark a page and assign the bookmark to 

a button or icon. Page navigation helps you direct you directly on required report view page or 

parameter. 
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11. Publishing the report 

• Step 1 :- Login to PowerBI with your Login ID 

• Step 2 :- Click on Publish in my workspace, Go to link which will appear after publish to 

access and preview PowerBI dashboard. 
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